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fonctionnalités de votre 
nouveau lecteur MP3
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP3 est tout 
cela à la fois et plus encore! Sa forme compacte se glisse facilement dans 
votre poche et sa technologie de pointe vous offre une qualité de son et 
d’image exceptionnelle et vous permet d’accéder à des jeux pleins d’action. 
Vous ne pourrez plus vous passer de votre nouveau lecteur MP3, que ce soit 
pour pratiquer une activité physique, télécharger vos chansons préférées, 
regarder des vidéos, vous divertir avec les jeux ou même écouter la radio. 
Utilisez-le ne serait-ce qu’une seule fois et vous vous demanderez comment 
vous avez pu vivre sans!

TOTALEMENT MULTIMEDIA
Nous l’appelons lecteur MP3 mais c’est bien 
plus que ça. Il permet d’affi cher des images, du 
texte, des vidéos d’écouter la radio et même 
de jouer.

LA NAVIGATION TACTILE !
Le pavé tactile vous permet de naviguer dans 
les différents menus très facilement.

L'ALLIANCE PARFAITE DE LA FORME ET 
DU FOND
Le lecteur MP3 n’est pas seulement discret et 
élégant. Il est également facile à utiliser et à 
manipuler.

ECOUTE PROLONGEE ET DUREE DE 
TELECHARGEMENT REDUITE !
Une batterie entièrement chargée permet de 
lire jusqu'à 25 heures de musique ou 4 heures 
de vidéo.
La durée de téléchargement a en outre été 
sensiblement réduite. Grâce au standard USB 
2.0, le lecteur est bien plus rapide que les 
modèles utilisant le format USB 1.1.

UNE QUALITE D’ECOUTE 
EXCEPTIONNELLE
Votre nouveau lecteur MP3 intègre la 
technologie sonore exclusive DNSe™ (Digital 
Natural Sound engine) de Samsung, fonction 
permettant de fournir un son d’une pureté 
et d’une richesse incroyable pour un plaisir 
d’écoute inégalé.



consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION

Indique un risque potentiel de blessure ou de dégât 
matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de 
décharge électrique ou de blessure lorsque vous utilisez le 
lecteur MP3, respectez les consignes de sécurité suivantes :

REMARQUE
Indique des conseils ou des pages auxquelles se référer 
afi n d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous 
blesser et de blesser d’autres personnes. 
Veuillez respecter scrupuleusement les consignes. 
Après avoir lu ce chapitre, rangez ce mode d’emploi dans un endroit sûr afi n 
de pouvoir vous y référer ultérieurement.



consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau
lecteur MP3. Lisez-le attentivement avant toute utilisation afi n d’éviter
d’endommager votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
 Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

 Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une 
telle situation se produit malgré tout, n’allumez pas le lecteur car vous 
risqueriez de vous électrocuter. Contactez plutôt le service clientèle de 
Samsung le plus proche de chez vous.

 N’utilisez pas ce produit en cas d’orage et de foudre. Vous vous 
exposeriez à un risque de dysfonctionnement ou de décharge électrique.

 N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.

 Faites particulièrement attention lorsque le câble USB du lecteur n’est 
pas branché et pend dans le vide. 
La fi che USB possède des bords tranchants et risque de vous blesser.

 Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie ; vous risqueriez de provoquer un incendie ou une 
décharge électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
 L’utilisation prolongée des écouteurs ou du casque peut fortement réduire 
votre acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée 
prolongée, votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus 
votre acuité auditive diminue (le niveau sonore d’une conversation ordinaire est compris 
entre 50 et 60 dB alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
 Si vous ressentez des bourdonnements dans les oreilles, réduisez le 
volume ou n’utilisez plus les écouteurs ou le casque.

PROTEGEZ VOTRE LECTEUR MP3
 Ne laissez pas l’appareil dans un lieu où la température excède 35°C 
(ex. : sauna ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
 Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
 Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
 Veillez à toujours enregistrer vos données les plus importantes. Samsung 
ne saurait être tenu pour responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
 Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou d’en détériorer la surface.
 Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
 Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de 
paramétrer l’option d’impression « Ajuster à la taille de la page » pour 
qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION



table des matières
FONCTIONS DE BASE

10
10  Contenu
11  Votre lecteur MP3
14  Ecrans
17  Utilisation des boutons tactiles
18  Chargement de la batterie
19  Entretien de la batterie
19  Mise sous et hors tension de l’appareil
20  Lecture de musique
20  Controle du volume
21  Verrouillage des boutons
21  Recherche de fi chiers a l’aide du 

« Dossier Navigateur »
22  Supression de fi chiers a l’aide du 

« Dossier Navigateur »
23  Modifi cation des reglages et des 

preferences
23  Réglages du style du menu
24  Réglages du son
25  Réglages de l’affi chage
26  Réglages de la langue
27  Réglages de l’heure
28  Réglages du système
30  Reinitialisation du systeme

EMODIO

31
31  Confi guration requise
32 Installation d’EmoDio
33  Transfert de fi chiers vers le lecteur 

avec EmoDio

          



table des matières
LECTURE DE 

FICHIERS MUSICAUX

36
36  Lecture par categorie
38  Pause
38  Recherche a l’interieur d’une plage
38  Lecture de la plage en cours a partir 

du debut
38  Lecture de la plage precedente
38  Lecture de la plage suivante
39  Création d’une liste de lecture avec 

EmoDio
39  Création d’une playlist
40  Ajout de fi chiers musicaux à une 

playlist que vous avez créé
41  Transfert d’une liste de lecture vers le 

lecteur avec EmoDio
42  Creation d’une liste de lecture sur 

votre lecteur MP3
43  Lecture d’une liste de lecture
44  Suppression d’un fi chier de la liste de 

lecture
44  Suppression de tous les fi chiers de la 

liste de lecture
45  Utilisation du menu musique

REGARDER UNE 
VIDÉO

53
53  Pause
54  Passer a une sequence specifi que
54  Lire le fi chier video precedent
54  Lire le fi chier video suivant
55  Utilisation du menu video

        



table des matières
AFFICHAGE DES 

IMAGES

57
57 Affi chage des images
58  Utilisation du menu image

ECOUTER LA 
RADIO FM

62
62  Pour utiliser la fonction mute (silence)
63  Pour rechercher des stations de radio 

FM
64  Utilisation du menu de la radio FM

UTILISATION DE 
LA DIFFUSION DE 

DONNÉES

73
73  Enregistrement d’une chaine
74  Creation d’un nouveau groupe de 

chaines
74  Transfert des donnees depuis 

<EmoDio>
75  Affi chage des diffusions de donnees

UTILISATION DU 
PACK PLUS

76
76  Lecture de texte
77  Utilisation du menu texte
80  Lecture de jeux fl ash
82  Reglage de l’alarme
85  Affi chage de l’horloge universelle



ANNEXE

89
89  Arborescence des menus
90  Caractéristiques du produit
92  License

table des matières
DÉPANNAGE

86
86 Dépannage



10 _ fonctions de base

fonctions de base
CONTENU
Votre nouveau lecteur MP3 est fourni avec les accessoires présentés 
ci-dessous. Si l’un de ces éléments ne se trouve pas dans l’emballage, 
contactez le service clientèle de Samsung.

Lecteur Ecouteurs

Câble USB CD d’installation

 Il se peut que les accessoires livrés avec votre appareil soient légèrement 
différents de ceux illustrés.
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VOTRE LECTEUR MP3

Ecran

Interrupteur Alimentation et 
Verrouillage 
Faites glisser dans le sens opposé à celui 
indiqué par la fl èche pour allumer/éteindre 
l’appareil.
Faites glisser dans le sens indiqué par la 
fl èche pour verrouiller les touches.

Trou de la cordelette

Bouton de réinitialisation
Si un dysfonctionnement du lecteur 
survient, appuyez sur le bouton de 
réinitialisation à l’aide d’un objet pointu 
afi n de réinitialiser le système.
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VOTRE LECTEUR MP3 (Suite)
Les boutons suivants sont des touches tactiles.

Bouton de retour en arrière
Appuyez légèrement pour aller à l’écran 

précédent.
Appuyez longuement sur ce bouton pour 

accéder à l’écran du menu principal.

Bouton d’augmentation du volume
Appuyez légèrement pour augmenter le volume 

ou accéder à l’élément/au menu précédent.

Bouton de lecture/pause, sélection 
Appuyez légèrement pour sélectionner la 
lecture/pause et la fonction et accéder à 

l’écran suivant.

Bouton d’accès au fi chier précédent
Ce bouton permet de sélectionner la plage/le 

menu précédent(e) ou de lire la plage en 
cours à partir du début.

Appuyez longuement sur ce bouton pour 
passer rapidement d’une plage à une autre.

Bouton de réduction du volume
Ce bouton permet de diminuer le volume ou 

d’accéder à l’élément/au menu suivant.

Bouton d’accès au fi chier suivant
Ce bouton vous permet d’accéder à la plage/

au menu suivant(e). 
Appuyez longuement sur ce bouton pour 

passer rapidement d’une plage à une autre.

Bouton de menu
Appuyez légèrement pour affi cher l'écran 

de menu..
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VOTRE LECTEUR MP3 (Suite)

Ecouteurs
Pour votre confort, les lettres L (écouteur 

gauche) et R (écouteur droit) sont 
gravées sur chaque écouteur. Ce cordon 

sert également d’antenne radio.

Prise pour écouteurs

Port USB
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ECRANS
Musique

1 Témoin du menu associé

2
Témoin verrouillage/alarme/
minuteur d’arrêt

3 Etat de la batterie

4
Témoin de lecture de la plage 
en cours/du nombre total de 
plages

5 Indicateur de vitesse de lecture

6 Heure actuelle

7 Durée de lecture totale

8
Affi chage Lecture/
Pause et Recherche

9 Témoin du mode Musique

10 Témoin du mode Lecture

11 Témoin du mode DNSe

12 Ecran Lect mus.

13 Titre de la plage

14 Barre d’état de la lecture

15 Durée de lecture actuelle

  Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.REMARQUE

Music

  Rising Sun

02:13 04:28

15/20
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ECRANS (Suite)
Vidéo

1
Témoin verrouillage/
alarme/minuteur d'arrêt 6 Témoin du mode Vidéo

2 Etat de la batterie 7 Nom du fi chier

3 Heure actuelle 8 Barre d'état de la lecture

4 Durée de lecture totale 9 Durée de lecture actuelle

5
Affi chage Lecture/
Pause et Recherche

Video Track 1

5

6

7

8

9

1

2

3

4
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ECRANS (Suite)
Image

1
Témoin verrouillage/alarme/
minuteur d'arrêt

2 Etat de la batterie

3 Témoin du fi chier en cours/
du nombre total de fi chiers

4 Heure actuelle

5
Etat de la lecture des fi chiers 
musicaux

6 Témoin du mode Image

7 Témoin du menu associé

8 Nom du fi chier

Radio FM
1 Heure actuelle

2 Etat de la batterie

3
Témoin verrouillage/alarme/
minuteur d'arrêt

4 Témoin du mode Radio

5 Affi chage Manuel/Présélectionné

6
Affi chage de la fréquence en 
cours (MHz)

7 Affi chage de la barre de fréquence radio

8 Affi chage RDS

[Ecran de prévisualisation]
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UTILISATION DES BOUTONS TACTILES
Appuyez légèrement sur le bouton tactile du bout du doigt.

 Afi n de ne pas endommager le bouton tactile, utilisez uniquement vos doigts pour 
l’activer.
Veillez toujours à avoir les mains propres avant d’utiliser votre appareil.
N’utilisez jamais le bouton tactile les mains gantées.
 Il est possible que le bouton ne fonctionne pas si vous utilisez votre ongle ou un 
autre objet tel qu’un stylo à bille.

REMARQUE
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CHARGEMENT DE LA BATTERIE
Chargez-la avant d’utiliser votre lecteur pour la première fois ou lorsque vous 
ne l’avez pas utilisé pendant une période prolongée.
La batterie de votre lecteur MP3 se charge complètement en environ quatre 
heures, mais cette durée peut varier en fonction de la confi guration de votre 
ordinateur.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion 
USB situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.

2

Affi chage à l’écran
USB connecté

1
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez ces consignes d’entretien 
et de rangement.
•  Rechargez et rangez l’appareil dans un lieu où la température est comprise 

entre 5°C et 35°C.
• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie. 
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.
 Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie du 
portable est entièrement chargée ou que l’ordinateur est lui-même relié à une prise secteur.
 La batterie rechargeable intégrée à ce produit ne peut pas être remplacée par 
l’utilisateur. Pour plus d’informations sur son remplacement, contactez votre 
fournisseur de services.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Faites glisser l’interrupteur  dans le sens opposé 
à celui indiqué par la fl èche.

L’appareil s’allume.

Mise hors tension de l’appareil
Faites à nouveau glisser l’interrupteur  dans 
le sens opposé à celui indiqué par la fl èche. 

L’appareil s’éteint.

 L’appareil s’éteint automatiquement lorsque aucun des boutons n’est actionné 
pendant une durée prédéfi nie en mode Pause (Pause). La durée par défaut de 
<Auto Power Off> (Extinction auto) est de 1 minute, mais vous pouvez la modifi er. 
Consultez la page 29 pour plus d’informations.

REMARQUE

REMARQUE

ATTENTION
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LECTURE DE MUSIQUE
Téléchargez des fi chiers musicaux sur votre nouveau lecteur MP3 à l’aide de 
EmoDio. 
Pour en savoir plus sur EmoDio, reportez-vous à la pages 33~35.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2.  Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <Music> (Musique), puis sur [ ].
3. Appuyez sur le bouton [Haut, Bas] et [ ] pour 

sélectionner le fi chier musical de votre choix.
4. Appuyez légèrement sur [ ].

La lecture du fi chier musical démarre.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

CONTROLE DU VOLUME
Appuyez légèrement sur le bouton [Haut, Bas].

L’icône du contrôle de volume s’affi che.
La plage de réglage du volume est comprise entre 0 et 30.
 Appuyez légèrement sur le bouton [Haut] pour augmenter le 
volume et sur le bouton [Bas] pour le diminuer.

REMARQUE

Music

  Rising Sun

02:13 04:28

15/20

Music

  Rising Sun

02:13 04:28

15/20
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VERROUILLAGE DES BOUTONS
La fonction Verrouillage permet de verrouiller tous les boutons du lecteur MP3 ;
ainsi, si vous appuyez sur une touche par mégarde lors de la lecture d’un 
fi chier, celle-ci ne sera pas interrompue.
1. Faites glisser l’interrupteur  dans le sens de 

la fl èche.
2. Faites glisser l’interrupteur  dans le sens 

opposé à celui indiqué par la fl èche pour désactiver la 
fonction de verrouillage.

RECHERCHE DE FICHIERS A L’AIDE DU 
« DOSSIER NAVIGATEUR »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser> 
(Dossier Navigateur).
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <File Browser> (Dossier Navigateur), puis sur [ ].
 La liste des dossiers <File Browser> (Dossier Navigateur) contenant 
des fi chiers musicaux, des listes de lecture, des fi chiers vidéo, 
des images, des diffusions de données, des textes et des fi chiers 
enregistrés apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le dossier souhaité.

4. Appuyez légèrement sur [ ] pour affi cher la liste des fi chiers 
dans le dossier sélectionné.

Appuyez légèrement sur [ ] pour aller à l’écran précédent.
5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier souhaité.
6. Appuyez légèrement sur [ ].

 La lecture du fi chier démarre.

Music

  Rising Sun

02:13 04:28

15/20
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SUPRESSION DE FICHIERS A L'AIDE DU « DOSSIER 
NAVIGATEUR »
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <File Browser> (Dossier Navigateur), puis 
sur [ ]. 

 Le contenu de la liste des dossiers <File Browser> (Dossier 
Navigateur) apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le dossier souhaité, puis sur [ ].

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier 
que vous souhaitez supprimer, puis sur [ ].

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner <Delete> 
(Supprimer), puis sur [ ].

Une fenêtre de confi rmation apparaît.

6.  Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner 
<Yes> (Oui), puis sur [ ].

Le fi chier sélectionné est supprimé.

 Une fois supprimés, les fi chiers ne peuvent plus être récupérés.

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Recorded Files

ATTENTION
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MODIFICATION DES REGLAGES ET DES PREFERENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

Réglages du style du menu
Vous pouvez modifi er l’aspect et la police du menu et supprimer l’image 
de fond d’écran du menu principal.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner <Menu Style> (Style du menu), 
puis sur [ ]. 

Le menu <Menu Style> (Style du menu) s’affi che.
4. Les boutons [Haut, Bas] et [ ] servent à régler des fonctions.

 Appuyez légèrement sur [ ] pour passer à l’élément suivant/sélectionner le menu.
 Appuyez légèrement sur le bouton [Haut, Bas] pour monter ou descendre dans le 
menu actuel.

Options de réglage du style du menu 
 Menu Design (Aspect du menu) : Vous pouvez modifi er le style de l’écran du menu principal. 
Choisissez entre <Sparkling> (Brillant), <Crystal> (Cristal) et <My Skin> (Mon habillage).
 Font (Police) : Vous pouvez modifi er le type de police du menu. 3 types de police sont proposés. 
Il est possible que pour certaines langues de menu, l’option <Font> (Police) soit désactivée.
Reset My Skin (Réinitialiser mon habillage) : Permet d’initialiser l’image de fond de l’écran 
tactile par l’image par défaut. Si vous réglez <Sparkling> (Brillant) ou <Crystal> (Cristal) dans 
<Menu Design> (Aspect du menu), <Reset My Skin> (Réinitialiser mon habillage) est désactivé.

REMARQUE

Settings

Menu Style
Sound
Display
Language
Time 
System
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du 
volume sonore.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Sound> (Son), puis sur [ ]. 

Le menu <Sound> (Son) s’affi che.

4. Les boutons [Haut, Bas] et [ ] servent à régler 
des fonctions.

Options de réglage du son 
 Master EQ (EG princ.) : Vous pouvez optimiser les réglages du son. 
Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner la 
fréquence que vous souhaitez paramétrer. Appuyez sur le bouton [Haut, Bas] 
pour régler le niveau de la fréquence sélectionnée, puis sur [ ].
 Beep Sound (Signal sonore) : Permet d’activer ou de désactiver l’émission d’un 
signal sonore lors des opérations effectuées sur l'écran tactile. Choisissez entre 
<Off> (Arrêt) et <On> (Marche). 
 Volume Limit (Limitation du Volume) : Vous pouvez éviter l’apparition de troubles 
auditifs en réglant l’intensité du volume sonore lors de l’utilisation des écouteurs. 
l’option <On> (Marche) fi xe le niveau maximal du volume à 15. Le niveau 
maximal du volume lorsque la limite est réglée sur <Off> (Arrêt) est de 30. Même 
si vous avez sélectionné <Off> (Arrêt), le volume reviendra au niveau 15 lorsque 
vous rallumerez le lecteur afi n de vous éviter toute lésion du système auditif.

Settings

Menu Style
Sound
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Language
Time 
System



fonctions de base _ 25

MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de l’affi chage
Modifi ez l'heure d'arrêt de l'affi chage, l'écran de veille et la luminosité 
de votre écran.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Display> (Affi cher), puis sur [ ]. 

Le menu <Display> (Affi cher) s’affi che.

4. Les boutons [Haut, Bas] et [ ] servent à régler des fonctions.

Options de réglage de l’affi chage
 Display Off (Affi ch. Désactivé) : Si aucun nombre n’est entré pour la sélection 
de la période, l’écran s’éteint automatiquement. Vous pouvez choisir entre 
<15sec>, <30sec>, <1min>, <3min>, <5min>, et <Always On> (Toujours 
allumé). Pour rallumer l’écran, il vous suffi t d’appuyer sur n’importe quel bouton. 
Screen Saver (Économiseur d’écran) : permet d’utiliser une image comme 
économiseur d’écran. Sélectionnez <Auto Change> (Chang. auto), <Sweet> 
(Doux), <Blue Rain> (Mélancolie), <Cheers> (Bravo), <Analog Clock> (Heure 
analogique), <Digital Clock> (Horloge num.) et réglez le délai d'attente. Vous 
avez le choix entre les options suivantes : <Off> (Arrêt), <15sec>, <30sec>, 
<1min>, <3min> et <5min>. Si aucun nombre n'est entré pour la sélection de 
la période, le système bascule l'image de l'économiseur d'écran. Vous pouvez 
changer l’économiseur d’écran en appuyant sur [ ] pendant qu’il est actif.
 Brightness (Luminosité) : Permet de régler la luminosité de l’écran d’affi chage. 
Sélectionnez un niveau <0-10>, où 10 est le plus lumineux.

Settings
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Settings

Menu Style
Sound
Display
Language
Time 
System

MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP3. Vous pouvez changer facilement de 
préférence de langue.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Language> (Langue), puis sur [ ]. 
Le menu <Language> (Langue) s’affi che.

4. Les boutons [Haut, Bas] et [ ] servent à régler 
des fonctions.

Options de réglage de la langue
 Menu : Permet de régler la langue du menu. Options disponibles 
<English>, <한국어>, <Français>, <Deutsch>, <Italiano>, <日本語>,<简体中文>,
<繁體中文>, <Español>, <Русский>, <Magyar>, <Nederlands>, <Polski>, 
<Português>, <Svenska>, <ไทย>, <Čeština>, <Ελληνικά>, <Türkçe>, <Norsk>, 
<Dansk>, <Suomi>, <Español (Sudamérica)>, <Português (Brasil)>, <Indonesia>, 
<Tiếng Việt>, <Bulgarian>, <Română>, <Українська>, <Slovenščina> et <Slovenský>.
 Contents (Sommaire) : Vous permet de régler la langue dans laquelle les 
informations de suivi et le texte seront affi chés. Options disponibles <English>, 
<Korean>, <French>, <German>, <Italian>, <Japanese>, <Simplifi ed Chinese>, 
<Tranditional Chinese>, <Spanish>, <Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, <Farsi>, 
<Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>, 
<Icelandic>, <Rumanian>, <Slovak>, <Slovene>, <Turkish> et <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages de l’heure
Cette option vous permet de régler la date/l’heure, le format de la date 
et même le fuseau horaire.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal. 
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Time> (Durée), puis sur [ ]. 

Le menu <Time> (Durée) s’affi che.

4. Les boutons [Haut, Bas] et [ ] servent à régler des fonctions.

Options de réglage de l’heure
 Date&Time (Date et heure) : Vous pouvez régler la date et l'heure actuelles. 
Appuyez légèrement sur le bouton [Haut, Bas] pour accéder à <Year, Month, 
Date, Hour, Min, AM/PM> (Année, Mois, Jour, Heure, Minute, AM/PM) et appuyez 
légèrement sur le bouton [Haut, Bas] pour régler chaque élément.
 Date Type (Type date) : Permet de régler le type d’affi chage de l’heure de 
l’horloge universelle. Choisissez entre <YY-MM-DD> (AA-MM-JJ), <MM-DDYY> 
(MM-JJ-AA) et <DD-MM-YY> (JJ-MM-AA).
Time Zone (Fuseau hr) : Permet de modifi er l’heure actuelle en sélectionnant 
le fuseau horaire d’une ville étrangère spécifi que. Vous devez commencer par 
régler le fuseau horaire pour pouvoir affi cher les informations relatives à l’heure 
mondiale. Reportez-vous à la page 85.

Settings

Menu Style
Sound
Display
Language
Time 
System



28 _ fonctions de base

MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Réglages du système
Sélectionnez le mode Veille, Début, Extinction auto ou Réglage par 
défaut adapté.
1. Appuyez longuement sur [ ] pour accéder à 

l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner <Settings> (Paramètres), 
puis sur [ ]. 

Le menu <Settings> (Paramètres) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <System> (Système), puis sur [ ]. 

Le menu <System> (Système) s’affi che.

4. Les boutons [Haut, Bas] et [ ] servent à régler des fonctions. 

Settings
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MODIFICATION DES REGLAGES ET DES PREFERENCES (Suite)
Options de réglage du système

 Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après l’écoulement 
de la durée préréglée. Options disponibles : <Off> (Arrêt), <15min>, <30min>, 
<60min>, <90min> ou <120min>.
 Start Mode (Mode Début) : Permet de défi nir l’écran de démarrage affi ché lors 
de la mise sous tension du lecteur. Choisissez entre <Home> (Dom.) et <Last 
State> (Dernier Etat). Sélectionnez <Home> (Dom.) pour démarrer le système 
avec l’écran du menu principal et <Last State> (Dernier Etat) pour affi cher l’écran 
du dernier menu utilisé.
 Auto Power Off  (Extinction auto) : Permet d’éteindre automatiquement l’appareil 
lorsque aucun bouton n’est actionné avant l’écoulement de la durée prédéfi nie en 
mode Pause. choisissez entre <15sec>, <30sec>, <1min>, <3min>, <5min> et 
<Always On> (Toujours allumé).
 Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage 
par défaut. Options disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) vous 
permet de réinitialiser l’appareil sur les réglages par défaut. <No> (Non) permet 
d’annuler les réglages par défaut.
Format (Formater) : Vous permet de formater la mémoire interne. Options 
disponibles : <Yes> (Oui) ou <No> (Non). 
Le réglage sur <Yes> (Oui) formate la mémoire interne et supprime tous les 
fi chiers du lecteur. En revanche, <No> (Non) ne lance pas le formatage de la 
mémoire interne. vérifi ez avant de lancer le formatage.
 About (A propos de) : Permet de vérifi er la version du micrologiciel et la capacité 
de la mémoire.
<Firmware Version> (Version du fi rmware) affi che la version actuelle du 
micrologiciel. <Used> (Utilisé) indique la mémoire actuellement utilisée, 
<Available> (Disponible) indique la capacité restante de la mémoire et 
<Total> indique la capacité totale de la mémoire.

 A propos de la mémoire intégrée
1 Go=1,000,000,000 octets : la capacité réelle formatée peut être inférieure, 
car le micrologiciel interne en utilise une partie.

REMARQUE
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REINITIALISATION DU SYSTEME
Si votre lecteur MP3 ne s’allume pas, ne lance pas de lecture de fi chier ou n’est 
pas reconnu par votre ordinateur lorsque vous le branchez, il est préférable de 
réinitialiser le système.

Appuyez sur le bouton de réinitialisation 
situé sur la partie inférieure de l'appareil à 
l'aide d'un objet pointu, comme une agrafe.

Le système est réinitialisé.
 La fonction Reset (Réinitialisation) ne permet 
pas de supprimer les renseignements de durée 
et les données enregistrées dans la mémoire 
intégrée.
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EmoDio
L’application logicielle EmoDio est facile à utiliser et vous permet de 
classer vos fi chiers sur votre ordinateur. Une fois vos fi chiers classés 
et organisés dans EmoDio, vous pouvez les transférer rapidement vers 
votre lecteur MP3 sans avoir à faire des recherches sur l’ensemble de 
votre disque dur pour retrouver le bon fi chier.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme à la confi guration minimale requise suivante 
pour que vous puissiez installer et exécuter EmoDio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque dur
• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10 ou ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou version ultérieure
• Mémoire vive 512 Mo ou plus
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INSTALLATION D’EMODIO
 Assurez-vous que le programme d’installation <EmoDio> a été lancé à partir 
du compte administrateur de votre ordinateur. Dans le cas contraire, <EmoDio> 
ne pourra pas être installé. Pour trouver le compte administrateur, veuillez vous 
reporter au manuel d’utilisation de votre ordinateur.

1. Insérez le CD d’installation fourni avec le 
lecteur MP3 dans le lecteur CD-ROM de 
votre ordinateur.

2. Cliquez sur <Install now> 
(Installer maintenant).

Suivez les instructions pour démarrer l’installation.
 L’installation de <EmoDio> démarre et une icône  s’affi che sur votre Bureau 
lorsque celle-ci est terminée.

 N’effectuez pas de mouvements brusques lorsque vous utilisez un CD-ROM installé à 
la verticale pour le chargement/le retrait du CD d’installation.

ATTENTION

ATTENTION
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
EMODIO
<EmoDio> vous permet de sélectionner et de classer des fi chiers et des 
dossiers avant de les transférer vers votre lecteur. Ainsi, le balayage des 
fi chiers sur votre lecteur MP3 devient plus facile et plus rapide. Le programme 
<EmoDio> est le moyen le plus simple de transmettre des fi chiers d’un 
ordinateur vers votre lecteur MP3.

1. Branchez l’extrémité la plus large du câble USB sur le port de connexion USB 
situé dans la partie inférieure du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
Le message <USB connected> (USB connecté) s'affi che sur l'écran tactile du lecteur.
 <EmoDio> démarre automatiquement lorsque vous branchez le lecteur sur votre 
ordinateur.
 Si le programme ne démarre pas automatiquement, double-cliquez sur l’icône  
<EmoDio> située sur le Bureau.

 La technologie de reconnaissance musicale et les données relatives sont fournies par 
Gracenote et Gracenote CDDB®  Music Recognition ServiceSM.
 CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote.

1

2

REMARQUE
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
EMODIO (Suite)
3. Cliquez sur l’icône correspondant au type de 
fi chier que vous souhaitez transférer.

      Cliquez sur  pour affi cher la liste des fi chiers
musicaux.
   Cliquez sur  pour affi cher la liste des
fi chiers vidéo.

 Cliquez sur  pour affi cher la liste des fi chiers
 image.

4. Cliquez sur <Add File> (Ajouter un fi chier) situé 
en bas de <EmoDio>.

La fenêtre <Open> (Ouvrir) apparaît.

5. Sélectionnez les fi chiers que vous souhaitez 
ajouter et cliquez sur <Open> (Ouvrir). 

 Ces fi chiers sont ajoutés à la liste située à gauche de 
l’écran <EmoDio>.

6. Dans la liste située à gauche, sélectionnez le 
fi chier à transférer.

7. Cliquez sur l’icône  .
Le fi chier sélectionné est transféré vers le lecteur.

5

76

4

3
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TRANSFERT DE FICHIERS VERS LE LECTEUR AVEC 
EMODIO (Suite)

 Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
 Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n 
d’éviter une mauvaise connexion.

 Avant de procéder au transfert du fi chier vidéo vers le lecteur à l’aide de la fonction 
<EmoDio>, le fi chier est tout d’abord converti automatiquement au format SVI. La 
taille du fi chier est également réglée automatiquement.
 Avant de procéder au transfert du fi chier image vers le lecteur à l’aide de la fonction 
<EmoDio>, celui-ci est tout d’abord converti automatiquement au format JPG. La 
taille du fi chier est également réglée automatiquement.
Toutes les fonctions sont désactivées durant le branchement.
 Si vous branchez le câble USB sur l’ordinateur alors que la batterie est faible, il 
faudra quelques minutes au lecteur pour se connecter à l’ordinateur.
 Il est recommandé d’utiliser le système de fi chiers FAT 32 lors du formatage du 
lecteur sur votre ordinateur.
  EmoDio met à votre disposition une fonction d’aide très complète. Si vous ne 
pouvez y trouver la réponse à votre question sur EmoDio, cliquez sur <MENU> 
(Menu) → <Help> (Aide) → <Help> (Aide) situé dans la partie supérieure du 
programme <EmoDio>.
 Qu'est-ce que la fonctionnalité SVI ?
L'entrelacement Samsung Audio Video (SVI) est un nouveau format vidéo 
développé et contrôlé par Samsung.

ATTENTION

REMARQUE
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lecture de fi chiers musicaux
 Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

LECTURE PAR CATEGORIE

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner 

<Music> (Musique), puis sur [ ].
La liste <Music> (Musique) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la liste 
souhaitée, puis sur [ ].

Le fi chier musical s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner le fi chier à 
lire, puis sur [ ].

La lecture du fi chier musical démarre.

REMARQUE

Now Playing
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LECTURE PAR CATEGORIE (Suite)

Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de la 
plage et le genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du fi chier 
musical correspondant. Un fi chier sans étiquette ID3 s’affi che comme [Unknown] (inconnu).
Now Playing (En lecture) :  Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de 

lecture du fi chier en cours.
Artists (Artiste) : Lecture par artiste
Albums : Lecture par album
Songs (Chansons)  : Lecture en ordre numérique ou alphabétique          
Genres : Lecture par genre
Playlists (Listes de lecture) : Lecture par liste
Recorded Files (Fichiers Enregistrés) : Affi che tous les fi chiers enregistrés.
Music Browser (Navig. musique) :  Permet d’affi cher tous les fi chiers musicaux enregistrés 

dans le dossier musical.

 Les fi chiers musicaux MP3 et WMA sont compatibles avec ce lecteur.
 Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
 Si vous débranchez les écouteurs pendant la lecture des données musicales, la 
lecture s'interrompt.
 Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au 
fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE
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PAUSE
1. Appuyez légèrement sur [ ] lorsque la lecture de la musique est en cours.

La lecture de la musique est interrompue.

2. Appuyez à nouveau sur [ ].
La lecture reprend à l’endroit où vous l’avez suspendue.

RECHERCHE A L’INTERIEUR D’UNE PLAGE
1. Appuyez longuement sur le bouton [Gauche, Droite] pendant que la plage 

sélectionnée est en cours de lecture.
 Ces boutons permettent d’effectuer la recherche vers le début ou la fi n de la plage.

2. Relâchez le bouton dès que vous souhaitez reprendre la lecture.
La lecture commence dès que vous relâchez le bouton.

LECTURE DE LA PLAGE EN COURS A PARTIR DU DEBUT
1. Appuyez légèrement sur le bouton [Gauche] après 3 secondes de lecture.

La plage en cours est lue à partir du début.

LECTURE DE LA PLAGE PRECEDENTE
Appuyez légèrement sur le bouton [Gauche] dans les 3 premières secondes de 
lecture.
Appuyez deux fois sur le bouton [Gauche] après 3 secondes de lecture.

La lecture de la plage précédente démarre.

LECTURE DE LA PLAGE SUIVANTE
Appuyez légèrement sur le bouton [Droite].

La lecture de la plage suivante démarre.

 Pendant la lecture de fi chiers VBR, la plage précédente peut ne pas être lue même 
si vous appuyez sur le bouton [Gauche] au cours des 3 premières secondes de 
lecture.

ATTENTION
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CRÉATION D’UNE LISTE DE LECTURE AVEC EMODIO
Grâce à <EmoDio>, vous pouvez créer votre propre collection ou liste de 
fi chiers audio.

Avant de démarrer -  Branchez le lecteur MP3 sur l’ordinateur.
EmoDio doit être installé sur votre ordinateur.

Création d’une playlist

1. Cliquez sur <Playlists> (Playlist) dans la partie supérieure de 
<EmoDio>.

La fenêtre Playlists apparaît.

2. Cliquez sur le bouton <Nouv. Playlist>  au bas de l’écran.
La fenêtre Créer listes de lecture apparaît.

3. Tapez le titre de la playlist et cliquez sur <OK>.
 Lors de la création d’une nouvelle liste de lecture, celle-ci sera nommée et 
enregistrée dans la section <Playlists> (Playlist) de <EmoDio> 

2

1

OK 3
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CRÉATION D’UNE LISTE DE LECTURE AVEC EMODIO 
(Suite)

Ajout de fi chiers musicaux à une playlist que vous avez créé

1. Cliquez sur <My PC> (Mon ordinateur) dans la partie supérieure de 
<EmoDio>.

La fenêtre Bibliothèque apparaît.

2. Cliquez sur le bouton <Playlists> dans le coin droit de la fenêtre.
La fenêtre Playlists apparaît.

3. Double-cliquez sur une liste de lecture dans la fenêtre de droite.
4. Sélectionnez les fi chiers que vous souhaitez transférer dans la fenêtre 

<Bibliothèque>.
5. Cliquez sur l’icône .

5
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CRÉATION D’UNE LISTE DE LECTURE AVEC EMODIO 
(Suite)

Transfert d’une liste de lecture vers le lecteur avec EmoDio

1. Cliquez sur <Playlists> (Playlist) dans la partie supérieure de 
<EmoDio>.

La fenêtre Playlists apparaît.

2. Sélectionnez une playlist dans la fenêtre <Playlists>.
3. Cliquez sur l’icône .

 La liste de lecture sélectionnée sera transférée vers le lecteur en passant par 
<File Browser> (Dossier Navigateur) → <Playlists> (Listes de lecture).

   Le lecteur peut lire jusqu'à 999 fi chiers musicaux par liste de lecture.

1

32 

REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez 
créer une Liste de lecture « Favoris » sans utiliser EmoDio ni votre ordinateur.
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <File Browser> (Dossier Navigateur), puis sur [ ]. 
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Music> (Musique), puis sur [ ]. 
Le(s) fi chier(s) musical/musicaux s’affi che(nt).

4. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
un fi chier à ajouter à la liste de lecture, puis sur [ ].

Le menu de la liste de lecture apparaît.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Add to Playlist> (Aj. à liste lect.), puis sur  [ ]. 

<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5) apparaît.

6. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner un numéro de liste de lecture pour ajouter le 
fi chier sélectionné, puis sur [ ].

 Le fi chier sélectionné est ajouté à la liste de lecture.
 Vérifi ez la liste de lecture dans <Music> (Musique) → <Playlists> 
(Listes de lecture) → <Playlist 1> (List lect 1) à <Playlist 5> (List 
lect 5) dans le menu principal.

 Vous pouvez ajouter jusqu'à 100 fi chiers musicaux dans chaque liste de lecture 
(<Playlist 1> (List lect 1) à <Playlist 5> (List lect 5)).REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <Music> (Musique), puis sur [ ].
La liste <Music> <Musique> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Playlists> (Listes de lecture), puis sur [ ]. 

La/Les liste(s) de lecture s'affi che(nt).

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner la liste de lecture de votre choix, puis sur [ ].

 Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée apparaissent.
 Si vous ne trouvez aucune liste de lecture, le message 
<No fi le.> (Aucun fi chier.) s’affi che à l’écran.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner un fi chier musical à lire, puis sur [ ].

La lecture du fi chier musical démarre.

 Reportez-vous aux pages 39 et 41 pour en savoir plus sur le 
transfert de la liste de lecture avec <EmoDio>.REMARQUE

Music
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Playlist 1

Life is cool
My love
Delete from Pla..
Delete All from Pla

Playlist 1

Life is cool
My love
Delete from Playlist
Delete All from ..

SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE
1. Appuyez longuement sur [ ] pour accéder à l’écran du 

menu principal.
2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <Music> (Musique), puis sur [ ].
La liste <Music> <Musique> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Playlists> (Listes de lecture), puis sur [ ]. 

La/Les liste(s) de lecture s'affi che(nt).
4. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner la liste de lecture de votre choix, puis sur [ ].
 Les fi chiers musicaux enregistrés dans la liste de lecture 
sélectionnée apparaissent.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner un fi chier à 
supprimer de la liste de lecture, puis sur [ ]. 

Le menu de la liste de lecture apparaît.
6. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner <Delete from 

Playlist> (Suppr. de liste lect.), puis sur [ ]. 
Une fenêtre de confi rmation s’affi che.

7. Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner <Yes> 
(Oui), puis sur [ ]. 

Le fi chier sélectionné est supprimé de la liste de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE LECTURE
Suivez les étapes 1 à 4 ci-dessus.
5. Appuyez légèrement sur [ ].

Le menu de la liste de lecture apparaît.
6. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Delete All from Playlist> (Suppr. tt de liste 
lect.), puis sur [ ]. 

Une fenêtre de confi rmation s’affi che.
7. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner <Yes> (Oui), puis sur [ ]. 
Tous les fi chiers sont supprimés de la liste de lecture.
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UTILISATION DU MENU MUSIQUE
Le menu Musique vous permet de gérer toutes les facettes de l’écoute (de la 
sélection des plages et des playlists au choix du fond d’écran durant l'écoute).

Régler l’effet sonore
Profi tez d’une qualité de son plus nette.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Sound Effect> (Effets 
sonores), puis sur [ ]. 

 Le menu <Sound Effect> (Effets Sonores) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner l’effet sonore souhaité, puis sur [ ].

Options d’effet sonore
Street Mode (Mode Rue) : Permet d’écouter clairement en extérieur grâce au 
fi ltrage de certains bruits de la rue. Sélectionnez <On> (Marche) ou <Off > (Arrêt).
Clarity (Netteté) : Vous bénéfi ciez d’un son plus clair et de meilleure qualité. 
Sélectionnez de <0-2>.

Pour quitter le menu, appuyez légèrement sur [ ].

Music

1.Life is cool

02:13 04:28

15/20

Sound Effect
DNSe
Play Mode
Music Play Scre..
Add to Alarm
Play Speed
Skip Interval

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à chaque 
genre musical.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <DNSe>, puis sur [ ]. 

Le menu <DNSe> s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner le DNSe souhaité, puis sur [ ]. 

  Choisissez entre <Normal>, <Rock>, <Vocal> (Voix), <Bass Boost> (Ampli. 
Basses), <Classical> (Classique), <Studio>, <Concert Hall> (Salle Concert), 
et  <User> (Utilisateur).
  Vous pouvez régler <EQ> (EG) et <3D & BASS> lorsque <User> 
(Utilisateur) est sélectionné. Reportez-vous à la page 47.

 Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation sonore conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de musique 
que vous écoutez.

REMARQUE

Music
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UTILISATION DU MENU MUSIQUE (Suite)
Régler la fonction Digital Natural Sound engine (DNSe) (Suite)
<EQ> (EG)
Vous pouvez paramétrer les fréquences sonores individuellement selon vos 
préférences.
1 Appuyez légèrement sur le bouton [Haut, Bas] dans 

le menu DNSe pour sélectionner <User> (Util.), puis 
sur le bouton [Droite].

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <EQ> (EG), puis sur [ ]. 

L’écran de réglage <EQ> (EG) apparaît.
3. Appuyez légèrement sur le bouton [Gauche, Droite] 

pour sélectionner la fréquence que vous souhaitez 
régler, puis sur le bouton [Haut, Bas] pour régler le 
niveau de la fréquence sélectionnée.

 Vous pouvez régler le niveau de la fréquence 
sélectionnée de <–10 ~ +10> <–10 à +10>.

4. Appuyez légèrement sur [ ].
Le réglage est terminé.

<3D & BASS>
Vous pouvez régler le son ambiophonique 3D et le niveau d’amplifi cation des 
basses fréquences.
1. Appuyez légèrement sur le bouton [Haut, Bas] dans 

le menu DNSe pour sélectionner <User> (Utilisateur), 
puis sur le bouton [Droite].

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <3D & BASS>, puis sur  [ ].

L’écran de réglage <3D & BASS> apparaît.
3. Appuyez légèrement sur le bouton [Gauche, Droite] 

pour sélectionner <3D> (3D) ou <Bass>, puis sur le 
bouton [Haut, Bas].

 Vous pouvez sélectionner un niveau <3D> compris 
entre 0 et 4 et <Bass> compris entre 0 et 4.

4. Appuyez légèrement sur [ ].
Le réglage est terminé.

Music

1.Life is cool
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UTILISATION DU MENU MUSIQUE (Suite)
Régler le mode de lecture
Permet de sélectionner le mode de lecture tel que les paramètres de 
répétition.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Play Mode> (Mode lecture), 
puis sur [ ]. 

Le menu <Play Mode> (Mode lecture) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner le mode de lecture souhaité, puis 
sur [ ].

Options du mode de lecture
Normal : Permet de lire toutes les plages dans l'ordre une seule fois.
Repeat (Répéter) : Permet de répéter tous les fi chiers du dossier en cours.
Repeat One (Répéter 1X) : Permet de répéter un fi chier.
Shuffl e (Aléatoire) : Permet de lire les fi chiers dans un ordre aléatoire.

Music

1.Life is cool
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UTILISATION DU MENU MUSIQUE (Suite)
Sélectionner l’écran de lecture musicale
Sélectionnez une image de fond d’écran parmi celles fournies ou 
sélectionnez l’une de vos propres images à affi cher lorsque vous écoutez 
de la musique.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Music Play Screen> (Ecran 
Lect mus.), puis sur [ ]. 

 Le menu <Music Play Screen> (Ecran Lect mus.) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner l’écran de lecture musicale 
souhaité, puis sur [ ].

Options de l’écran de lecture musicale
Type 1 ~ Type 3 (Type 1 à Type 3) : Permet de sélectionner l’écran de lecture 
musicale souhaité.
Album Info. (Info.album) : Les informations concernant le nom de l’artiste, l’album 
et le genre s’affi chent si celles de l’étiquette ID3 sont enregistrées dans le fi chier 
musical.
Album Art (Image CD) : L’image de la jaquette du CD s'affi che si une image 
de jaquette fi gure dans les informations de l’étiquette 3D du fi chier musical. Les 
images de la jaquette du CD d’une taille inférieure à 200 pixels (horizontal) x 200 
pixels (vertical) sont prises en charge.
Auto Change (Chang. auto) : Change automatiquement de type (<Type 1>  à 
<Type 3>) chaque fois qu'un fi chier musical différent est lu.

 Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un 
champ commentaire.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Ajouter à la sonnerie de l’alarme
Vous pouvez ajouter votre fi chier musical favori à la liste des sonneries 
d’alarme afi n de l’écouter lorsque l’alarme se déclenche. Reportez-vous à 
la page 82 pour régler l’alarme.
1. Sélectionnez un fi chier musical à ajouter à la liste 

des sonneries et appuyez sur [ ].
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Add to Alarm> (Ajouter à 
alarme), puis sur [ ].

 La musique sélectionnée est ajoutée à la liste des 
sonneries d’alarme.
 Un seul fi chier musical peut être ajouté à la sonnerie d’alarme.

Régler la vitesse de lecture
Accélérez ou ralentissez votre musique préférée en réglant la vitesse de lecture.
1. Appuyez légèrement sur [ ] tout en écoutant de la 

musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Play Speed> (Vitesse de lecture), puis 
sur [ ]. 

Le menu <Play Speed> (Vitesse de lecture) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner la vitesse de lecture souhaitée, puis sur [ ].
 Choisissez entre <X 0.7>, <X0.8>, <X 0.9>, 
<X 1.0(Normal)>, <X 1.1>, <X 1.2> et <X 1.3>.
 Plus le nombre est élevé, plus la vitesse est rapide.

 La vitesse de lecture réglée peut être légèrement différente de la vitesse 
réelle en fonction du fi chier.REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)
Régler l’intervalle de saut
Vous pouvez avancer rapidement dans un fi chier à intervalles variés. 
Sautez l’ensemble de la plage ou sautez plusieurs secondes à la fois.
1. Appuyez légèrement sur [ ] tout en écoutant de 

la musique.
Le menu <Music> (Musique) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Skip Interval> (Saut 
Intervalle), puis sur [ ]. 

Le menu <Skip Interval> (Saut Intervalle) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner l’intervalle de saut souhaité, puis 
sur [ ]. 

 Choisissez entre <1 Song> (1 chanson), <5sec>, <10sec>, <30sec> et 
<1min>.

 Si le fi chier a été ouvert avec un débit binaire variable, il se peut que la 
longueur réelle de l’intervalle de saut soit légèrement différente de celle que 
vous avez sélectionnée.

REMARQUE
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Music
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UTILISATION DU MENU MUSIQUE (Suite)
Réglage d'un signet
La défi nition d'un signet vous permet de retrouver facilement 
la position correspondante ultérieurement.
1. Appuyez légèrement sur [ ] à l'endroit voulu pendant la 

lecture de la musique.
Le menu <Music> (Musique) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Bookmark> (Signet), puis sur [ ].

Le menu <Bookmark> (Signet) apparaît.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Add Bookmark> (Ajouter signet), puis sur 
[ ].

 Le point de lecture/d'arrêt courant est ajouté au signet.
 Le symbole [ │ ] apparaît dans la barre de progression de la lecture.

 La fenêtre Réécrire apparaît si un signet a déjà été défi ni. Si vous sélectionnez <Yes> 
(Oui), le signet préalablement défi ni est supprimé et un nouveau signet est ajouté.
 Un signet peut être défi ni pour chaque fi chier musical (50 signets au maximum).

Accéder à lire/Supprimer un signet
1. Appuyez légèrement sur [ ] tout en écoutant de la musique.

Le menu <Music> (Musique) s'affi che.
2. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Bookmark> (Signet), puis sur [ ].
Le menu <Bookmark> (Signet) apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Go to Bookmark> (Accéd. à Signet) ou 
<Delete Bookmark> (Supprimer signet), puis sur [ ].

 Lorsque vous avez sélectionné <Go to Bookmark> (Accéd. à 
Signet), le lecteur accède au signet sélectionné et commence 
la lecture.
 L'option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier musical.

REMARQUE
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regarder une vidéo
 Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie. Transférez un fi chier vidéo vers le lecteur. Reportez-vous à la page 33~35

 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Videos> (Vidéos), puis sur [ ].

La liste des <Videos> (vidéos) s'affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner une vidéo à lire, puis sur [ ].

 La lecture du fi chier vidéo sélectionné démarre horizontalement.

PAUSE
1. Appuyez légèrement sur [ ] 

pendant la lecture de la vidéo.
Le lecteur met la lecture en pause.

2. Appuyez à nouveau sur [ ].
Le lecteur reprend au dernier point de lecture.

 Avant de procéder au transfert du fi chier vidéo vers le lecteur à l’aide de la fonction 
<EmoDio>, le fi chier est tout d’abord converti automatiquement au format SVI. 
La taille du fi chier est également réglée automatiquement.

REMARQUE

REMARQUE

Bouton [Haut, Bas]

Bouton [Gauche, Droite]

<En affi chage horizontal>
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PASSER A UNE SEQUENCE SPECIFIQUE
1. En affi chage horizontal, appuyez longuement sur le 

bouton [Gauche, Droite].
 Cette option vous permet de reculer ou d’avancer dans le 
fi chier vidéo en cours.

2. Relâchez le bouton une fois la position souhaitée 
atteinte.

 La lecture de la vidéo démarre à partir de cette position.

LIRE LE FICHIER VIDEO PRECEDENT
Appuyez légèrement sur le bouton [Gauche] dans 
les 3 secondes suivant le démarrage de la lecture du 
fi chier en cours.
Appuyez deux fois sur le bouton [Gauche] 3 secondes 
après le démarrage de la lecture du fi chier en cours.

Cette opération permet de revenir à la vidéo précédente.

LIRE LE FICHIER VIDEO SUIVANT
Appuyez légèrement sur le bouton [Droite].

Cette opération permet d’accéder au fi lm suivant. Video Track 2

Video Track 1

Video Track 1
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UTILISATION DU MENU VIDEO
Réglage d'un signet
La défi nition d'un signet vous permet de retrouver facilement la position 
correspondante ultérieurement.
1. Appuyez sur [ ] pour affi cher la scène 

souhaitée durant la lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Add Bookmark> (Ajouter 
signet), puis sur [ ].

 Le point de lecture/d'arrêt courant est ajouté au signet. 
 Le symbole [ │ ] apparaît dans la barre de 
progression de la lecture. 

 La fenêtre Réécrire apparaît si un signet a déjà été défi ni. Si vous sélectionnez <Yes> 
(Oui), le signet préalablement défi ni est supprimé et un nouveau signet est ajouté.
 Un signet peut être défi ni pour chaque fi chier vidéo (50 signets au maximum).

Accéder à lire/Supprimer un signet
1. Appuyez légèrement sur [ ] pendant la lecture 

de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Go to Bookmark> (Accéd. 
à Signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur [ ].

 Lorsque vous avez sélectionné <Go to Bookmark> 
(Accéd. à Signet), le lecteur accède au signet sélectionné et commence la lecture.
 L’option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier vidéo.

Pour quitter le menu, appuyez légèrement sur [ ].

REMARQUE

REMARQUE
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UTILISATION DU MENU VIDEO (Suite)
Régler la fonction Digital Natural Sound engine (DNSe)
Permet de choisir le type de son convenant le mieux à chaque genre de 
vidéo.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <DNSe>, puis sur [ ].

Le menu <DNSe> s’affi che.
3. Appuyez légèrement sur le bouton [Haut, 

Bas] pour sélectionner le DNSe souhaité, puis sur [ ].
 Choisissez entre <Normal>, <Drama> (Drame) et <Action>.

 Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction 
d’optimisation du son conçue par Samsung pour les lecteurs MP3. Cette 
option offre différents réglages sonores visant à améliorer le type de musique 
que vous écoutez.

Régler la luminosité
Vous pouvez régler la luminosité de l’écran.
1. Appuyez légèrement sur [ ] pendant la 

lecture de la vidéo.
Le menu <Video> (Vidéo) s'affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Brightness> 
(Luminosité), puis sur [ ]. 

Le menu <Brightness> (Luminosité) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, 

Bas] pour régler la luminosité souhaitée, puis sur [ ].
Choisissez entre <0~10>.

Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

Add Bookmark
Go to Bookmark
Delete Bookmark
DNSe
Brightness

REMARQUE
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affi chage des images
 Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Pictures> (Images), puis sur [ ].

La fenêtre de prévisualisation apparaît.

3. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 
Droite] pour sélectionner l’image que vous souhaitez 
affi cher, puis sur [ ].

L’image sélectionnée s'affi che.
 Appuyez légèrement su [ ] pour aller à la fenêtre de prévisualisation.

Accéder à l’image 
précédente/suivante
En affi chage horizontal, appuyez 
légèrement sur le bouton 
[Gauche, Droite].

 L’image précédente/suivante 
s'affi che.

 Un fi chier JPG comportant des données 
incorrectes sous forme de vignette s’affi che dans .
Certaines images peuvent être affi chées lentement.
 Avant de procéder au transfert du fi chier image vers le lecteur à l’aide de la fonction 
<EmoDio>, celui-ci est tout d’abord converti automatiquement au format JPG. La taille du 
fi chier est également réglée automatiquement.
 Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour 
rechercher une image. Reportez-vous à la page 21.

REMARQUE

REMARQUE

Bouton [Haut, Bas]

Bouton [Gauche, Droite]
<En affi chage horizontal>
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UTILISATION DU MENU IMAGE
Ecouter de la musique pendant l’affi chage de votre image
Vous pouvez écouter la dernière chanson lue pendant l’affi chage de votre image.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

de l’image.
Le menu <Picture> (Image) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Music> (Musique), puis sur [ ].

Le menu <Music> (Musique) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner le mode souhaité, puis sur [ ].
 <Off> (Arrêt) : Aucune musique de fond ne peut être lue pendant l’affi chage d’une image.
 <On> (Marche) : Vous pouvez écouter la dernière musique lue pendant l’affi chage de 
votre image.

Visionner un diaporama
Marche à suivre  1
1. Appuyez légèrement sur [ ] pendant l’affi chage de 

l’image.
 Le symbole [ ] s’affi che à l’écran et le lecteur démarre le 
diaporama.

Marche à suivre  2
1. En mode de prévisualisation de l’image, appuyez 

légèrement sur [ ].
La fenêtre Démarrer diaporama apparaît.

2. Appuyez légèrement sur [ ].
 Le symbole [ ] s’affi che à l’écran et le lecteur démarre le 
diaporama.

Pour quitter le menu, appuyez légèrement sur [ ].

Pictures 1/8

Picture Image 1

Start Slideshow

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin



affi chage des images _ 59

UTILISATION DU MENU IMAGE (Suite)
Arrêt du diaporama

Marche à suivre  1
1. En mode diaporama, appuyez légèrement 

sur [ ].
Le diaporama s’arrête.

Marche à suivre  2
1. En mode diaporama, appuyez légèrement 

sur [ ].
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner 
<Stop Slideshow> (Arrêt diaporama), puis sur [ ]. 

Le diaporama s’arrête.

Régler la vitesse du diaporama
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Slideshow 
Speed> (Vitesse diaporama), puis sur [ ]. 

 Le menu <Slideshow Speed> (Vitesse 
diaporama) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner la 
vitesse souhaitée, puis sur [ ].

 Choisissez entre <Fast> (Rapide), <Normal> et <Slow> (Lent).

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Stop Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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UTILISATION DU MENU IMAGE (Suite)
Agrandir une image
Vous pouvez zoomer sur une image.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Zoom>, puis sur [ ]. 

Le menu <Zoom> s’affi che.
3. Appuyez légèrement sur le bouton [Haut, 

Bas] pour sélectionner le niveau de zoom 
souhaité, puis sur [ ]. 

Choisissez entre <100%>, <200%> et <400%>.
4. Appuyez légèrement sur le bouton [Haut, Bas, Gauche, Droite] pour 

accéder à la partie de l’image que vous souhaitez agrandir.

Annuler le zoom

Appuyez légèrement sur [ ] dans une vue agrandie de l’image.
 Cette fonction permet de revenir à la taille initiale.

 L’agrandissement d’un fi chier image volumineux peut prendre un certain temps.
REMARQUE

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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UTILISATION DU MENU IMAGE (Suite)
Pour faire pivoter une image
Vous pouvez faire pivoter l’image selon vos envies.
1. Appuyez légèrement sur [ ] pendant 

l’affi chage de l’image.
Le menu <Pictures> (Images) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, 
Bas] pour sélectionner <Rotate> (Pivoter), 
puis sur [ ].

Le menu <Rotate> (Pivoter) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, 

Bas] pour sélectionner l’angle souhaité, puis sur [ ]. 
 Choisissez entre <Left 90°> (Gauch 90°), <Right 90°> (90° droite) et <180°>.

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.
1. Sélectionnez le fi chier image à défi nir 

comme image de fond d'écran et appuyez 
légèrement sur [ ].

Le menu <Pictures> (Images) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, 

Bas] pour sélectionner <Select as My Skin> 
(Sél. comme habillage), puis sur [ ]. 

 La fenêtre de confi rmation d’enregistrement 
apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Yes> (Oui), puis sur [ ].

 L'image sélectionnée est défi nie comme fond d'écran.
 Si <My Skin> (Mon habillage) est sélectionné dans <Settings> (Paramètres) 
→ <Menu Style> (Style du menu)→ <Menu Design> (Aspect du menu), 
l’image défi nie s’affi che.

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin

Music
Start Sildeshow
Slideshow Speed
Zoom
Rotate
Select as My Skin
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ecouter la radio FM
 Avant de démarrer-  Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 

batterie.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <FM Radio> (Radio FM), puis sur [ ].

La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (SILENCE)
1. Appuyez légèrement sur [ ] lorsque vous écoutez la radio FM.

Le son est désactivé.

2. Appuyez à nouveau sur [ ] pour reprendre l’écoute.

 Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez des 
fréquences. Les écouteurs sont utilisés comme antennes de réception des ondes FM.
 Dans les zones où la qualité de réception est mauvaise, il se peut que le lecteur ne 
détecte aucune fréquence FM.

REMARQUE

REMARQUE
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POUR RECHERCHER DES STATIONS DE RADIO FM
1. Appuyez longuement sur le bouton [Gauche, Droite] et 

relâchez en mode Manuel.
 La recherche s’arrête sur la fréquence la plus proche du point de 
relâchement du bouton.

OU,

1. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
rechercher les fréquences une par une en mode Manuel.

Change de fréquence à chaque nouvelle pression du bouton.

Searching

BBC R2
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UTILISATION DU MENU DE LA RADIO FM
Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche 
manuelle d’une fréquence à la fois sur la bande FM.
1. Appuyez légèrement sur [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Go to Preset Mode> (Aller au 
mode pré-progr), puis sur [ ]. 

<Preset> s’affi che.

 Si aucune fréquence de présélection n’est défi nie, le 
lecteur ne passe pas en mode Présélection.

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.
1. Appuyez légèrement sur [ ] en mode Présélection.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Go to Manual Mode> (Aller au 
mode manuel), puis sur [ ]. 

<Manual> s’affi che.

REMARQUE

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection
Vous pouvez enregistrer jusqu’à 30 stations dans la mémoire de votre 
lecteur MP3 et y accéder en appuyant simplement sur un chiffre. 
Le lecteur MP3 peut soit choisir uniquement les stations souhaitées 
(manuellement) ou rechercher et enregistrer automatiquement les 
stations locales.
Manuel : sélectionnez uniquement les stations que vous souhaitez 
enregistrer
1. Appuyez légèrement sur le bouton [Gauche, 

Droite] pour sélectionner une fréquence à 
prérégler en mode manuel, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Add to Preset> (Ajouter aux 
présél.), puis sur [ ].

 La fréquence sélectionnée est ajoutée à la liste de 
présélections.

3. Pour défi nir un numéro préréglé pour les autres fréquences, 
suivez les étapes 1 à 2 ci-dessus.

Si la même fréquence est déjà défi nie, le réglage est désactivé.
REMARQUE

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour enregistrer des stations dans la mémoire de 
présélection (Suite)
Automatique : enregistrez automatiquement toutes les stations 
captées par le lecteur
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Auto Preset> (Présélection 
auto), puis sur [ ].

Une fenêtre de confi rmation s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, Droite] 
pour sélectionner <Yes> (Oui), puis sur [ ].

 Jusqu’à 30 fréquences radio sont réglées 
automatiquement.

Pour annuler la présélection automatique
Si vous souhaitez annuler la présélection automatique, appuyez 
légèrement sur [ ] au cours du processus.

 La présélection automatique est annulée et seules les fréquences réglées 
jusque-là sont enregistrées.

 Si vous vous rendez dans une autre région avec votre lecteur MP3, 
vous souhaiterez peut-être régler à nouveau les stations enregistrées. 
Pour supprimer les stations préréglées et en enregistrer de nouvelles, 
il suffi t de répéter le processus.

REMARQUE

Go to Preset Mo..
Add to Preset
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée
En mode Présélection, appuyez légèrement sur 
le bouton [Gauche, Droite] pour faire défi ler les 
stations présélectionnées.

Vous pouvez écouter la fréquence radio enregistrée.

Pour supprimer une présélection 
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. En mode Présélection, appuyez légèrement sur 

le bouton [Gauche, Droite] pour rechercher une 
fréquence présélectionnée à supprimer, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Delete from Preset> (Suppr. 
de liste lect.), puis sur [ ].

La fréquence sélectionnée est supprimée.

3. Pour supprimer les autres fréquences 
présélectionnées, suivez les étapes 1 à 2 ci-dessus.

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

BBC R2
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Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

UTILISATION DU MENU DE LA RADIO FM (Suite)
Enregistrer un programme FM
Vous pouvez à tout moment enregistrer un programme FM tout en écoutant la radio.
1. Appuyez légèrement sur le bouton [Gauche, Droite] pour 

sélectionner une fréquence à enregistrer en mode Radio 
FM, puis sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Start Recording> (Démarrer enreg.), puis 
sur [ ].

 Le nom du fi chier créé automatiquement s'affi che et 
l'enregistrement démarre.

Pour arrêter un enregistrement
1. Appuyez légèrement sur [ ] pendant l’enregistrement.

 Un message apparaît vous demandant si vous souhaitez 
écouter le fi chier que vous venez d’enregistrer.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Yes> (Oui) ou <No> (Non), puis sur [ ].

 Sélectionner <Yes> (Oui) vous permet de lire le fi chier que 
vous venez d’enregistrer.
 Sélectionner <No> (Non) ne vous permet pas de lire le fi chier 
enregistré.
 Le fi chier est enregistré à l’emplacement suivant : <File 
Browser> (Dossier Navigateur) → <Recorded Files> (Fichiers 
Enregistrés) → <FM Radio> (Radio FM).

 Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement radio FM.
 Vous pouvez effectuer jusqu'à 30 heures d'enregistrement (sur la base de 128 Kbps, 2 Go)
 Le nom du fi chier enregistré est spécifi é automatiquement, par exemple, sous la 
forme « FM_XXX.mp3 ». « FM » indique que le fi chier est un enregistrement de radio 
FM et « XXX » correspond au numéro du fi chier enregistré.

REMARQUE
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Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

UTILISATION DU MENU DE LA RADIO FM (Suite)
Pour défi nir la qualité d'enregistrement FM
Vous pouvez choisir la qualité d'un enregistrement radio FM.
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <FM REC Quality> (Qualité ENR FM), puis 
sur [ ].

 Le menu de la qualité de l’enregistrement FM apparaît.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner le niveau de qualité souhaité, puis sur [ ].
 Vous avez le choix entre les options suivantes : <Super High 
(192kbps)> (Très élevé (192 kbps)), <High (160 kbps)> (Haut 
(160kbps)) et <Normal (128kbps)>.
 Plus le nombre est élevé et plus la qualité audio et le volume du fi chier seront élevés.

Pour régler la Sensibilité FM
Pour recevoir plus ou moins de fréquences radio FM, paramétrez la fonction FM 
Sensitivity (Sensibilité FM).
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.
2. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <FM Sensitivity> (Sensibilité FM), puis sur 
[ ].

Le menu <FM Sensitivity> (Sensibilité FM) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner le niveau de recherche souhaité, puis sur [ ].
  Choisissez entre <High> (Haut), <Middle> (Milieu) et <Low> (Bas).
 Le réglage <High> (Haut) vous permet de recevoir le plus grand nombre de fréquences.

Pour quitter le menu, appuyez légèrement sur [ ].

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region

REMARQUE
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en prévision d’un 
voyage à l’étranger.
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <FM Region> (Région Radio), 
puis sur [ ].

Le menu <FM Region> (Région Radio) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner la zone régionale de la radio FM, 
puis sur [ ].

  Choisissez entre <Korea/US> (Corée/USA), <Japan> (Japon) ou <Other 
Countries> (Autres pays).

 Les fréquences radio que vous avez enregistrées précédemment seront 
supprimées si vous modifi ez le réglage <FM Region> (Région FM) de votre 
lecteur.
 La région FM peut être supprimée ou modifi ée en fonction de la région cible 
du lecteur.
  Bande de fréquences par région
- Korea/US (Corée/USA) : Recherchez des fréquences FM comprises entre 
  87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan (Japon) : Recherchez des fréquences FM comprises entre 76,0 
  MHz et 108 MHz pour les lecteurs de 100 kHz.
-  Other Countries (Autres pays) : Recherchez des fréquences FM comprises 

entre 87,50 MHz et 108,00 MHz pour les lecteurs de 50 kHz.

REMARQUE

Go to Manual M..
Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
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UTILISATION DU MENU DE LA RADIO FM (Suite)
Réglage de l’affi chage RDS
La fonction Système de Radiocommunication de Données (RDS) permet 
la réception et l’affi chage de messages comme la diffusion d’informations. 
Les informations relatives aux programmes (ex. : actualités, sport ou 
musique) ou aux stations de radiodiffusion s’affi chent sur cet écran.
1. Appuyez légèrement sur [ ] en mode Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <RDS Display> (Affi chage 
RDS), puis sur [ ].

Le menu <RDS Display> (Affi chage RDS) s’affi che. 

3. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner le mode Affi chage RDS, puis sur 
[ ].

 Vous avez le choix entre les options suivantes : <Program Service> (Service 
de programme) et <Program Type> (Type de programme).

Options d'affi chage RDS
Program Service (Service de programme) : Permet d’affi cher le nom de la station 
de radiodiffusion. Il est composé de 8 caractères. Si les informations concernant 
le service de programme sont reçues, le nom de ce dernier (BBC, AFO, NDR, 
etc.) s’affi che à l’écran. Si les informations concernant le service de programme 
ne sont pas reçues, la fréquence FM initiale s’affi che.
Program Type (Type de programme) : Permet d’affi cher le type de programme 
en cours de diffusion.

 Si la puissance du signal FM est faible, les informations RDS ne s’affi chent 
pas.REMARQUE

Delete from Pre..
Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
RDS Display
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Ajouter à la sonnerie de l’alarme
Vous avez la possibilité d'ajouter votre radio FM à la liste des sonneries 
d'alarme. Vous pourrez ainsi l'écouter la prochaine fois que l'alarme se 
déclenchera. Reportez-vous à la page 82 pour régler l’alarme.
1. Sélectionnez une fréquence radio à ajouter 

à la liste des sonneries d'alarme et appuyez 
légèrement sur [ ].

Le menu <FM Radio> (Radio FM) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Add to Alarm> (Ajouter à 
alarme), puis sur [ ].

 Si vous réglez la sonnerie d'alarme sur <FM Radio> 
(Radio FM) dans les réglages de l'alarme, vous pourrez 
écouter la radio FM.

Auto Preset
Start Recording
FM REC Quality
FM Sensitivity
FM Region
RDS Display 
Add to Alarm
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utilisation de la diffusion de données
Avec <EmoDio>, vous pouvez transférer vers le lecteur les informations relatives au 
blog et les fi chiers enregistrés au format RSS.

 Qu'est-ce que le format RSS ?
RSS correspond à Rich Site Summary ou Really Simple Syndication. Il s’agit d’un système 
de transfert de données XML utilisé pour fournir aux utilisateurs, de manière plus pratique et 
plus facile, des informations sur les sites Internet fréquemment mis à jour (Actualités, Blogs).
 Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement les informations mises à jour sans avoir à 
vous rendre sur les sites d’actualités, les blogs ou les UCC.
Avant de démarrer –  EmoDio doit être installé sur votre ordinateur.

Reportez-vous à la page 32.

ENREGISTREMENT D’UNE CHAINE
Vous pouvez créer une nouvelle chaîne en enregistrant les sites Internet ou les 
pages Web pris(es) en charge par le système RSS.
1. Cliquez sur le bouton <Subscribe> 

(S’abonner) situé au bas de l’écran 
<Datacasts> (Dif. donn.) de <EmoDio>.

2. Saisissez une adresse dans <URL> et cliquez sur 
<►Next> (►Suivant).

 Lorsque vous copiez une adresse Internet et que 
vous cliquez sur <Subscribe> (S’abonner), l’adresse 
copiée s’affi che automatiquement dans l’<URL>.
 La fenêtre de confi rmation du réglage s’affi che si 
l’adresse Internet prend en charge le format RSS.

3. Cliquez sur <OK>.
La chaîne souhaitée est enregistrée.
L’icône  s’affi che dans Datacasts (Dif. donn.) pour le canal enregistré.

 Reportez-vous à <Datacasts> (Dif. donn.) de <EmoDio> pour obtenir des instructions 
détaillées.

REMARQUE

REMARQUE

2

2
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CREATION D’UN NOUVEAU GROUPE DE CHAINES
Vous pouvez créer un nouveau groupe afi n de gérer les chaînes par catégorie.
1. Cliquez sur le bouton <New Group> (Nouveau 

groupe) situé au bas de l’écran <Datacasts> 
(Dif. donn.) de <EmoDio>.

2. Saisissez un nom de groupe et une description et 
cliquez sur <OK>.

TRANSFERT DES DONNEES DEPUIS <EMODIO>
Avant de démarrer –  Branchez le lecteur sur l'ordinateur. EmoDio doit être installé 

sur votre ordinateur. Reportez-vous à la page 32.
1.  <EmoDio> démarre automatiquement lorsque vous 

branchez le lecteur sur votre ordinateur.
 Si le programme ne démarre pas 
automatiquement, double-cliquez sur l’icône  
<EmoDio> située sur le Bureau.

2. Cliquez sur <Datacasts> (Dif. donn.) située dans la 
partie supérieure de <EmoDio>.

 La liste de chaînes du groupe de diffusion de 
données s’affi che.

3. Cliquez sur la chaîne du groupe souhaité.
4. Cliquez sur la chaîne souhaitée.
5. Sélectionnez l’élément que vous souhaitez transférer.
6. Cliquez sur l'icône  .

 L’élément de la chaîne sélectionnée est transféré vers le lecteur dans <File Browser> 
(Dossier Navigateur) → <Datacasts> (Dif. donn.).

Cliquez sur  dans la partie supérieure de <EmoDio> pour accéder à l’écran précédent.
 Dans <Datacasts> (Dif. donn.) de <EmoDio>, si l’élément comporte une pièce jointe, 
vous pouvez télécharger ce dernier sur le lecteur. Cependant, il est possible que le 
fi chier joint ne puisse pas être téléchargé en fonction de la politique de sécurité du 
site Internet.

REMARQUE

2
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AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à <Datacasts> (Dif. donn.).

 Avant de démarrer- Transfert de l’élément de chaîne souhaité vers le lecteur avec 
<EmoDio>. Reportez-vous à la page 74.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Datacasts> (Dif. donn.), puis sur [ ].

La liste de diffusion s'affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner la liste des chaînes souhaitée, puis sur [ ].

 Le titre est le même que celui de la chaîne ajoutée à 
<Datacasts> (Dif. donn.) dans <EmoDio>.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le titre de l’élément souhaité, puis sur [ ].

 La liste des fi chiers s'affi che.

Icône  : Texte principal de l’élément transféré
Icône : Fichier image
Icône  : Fichier musical
Icône : Fichier vidéo

5. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le fi chier souhaité, puis sur [ ].

La lecture du fi chier sélectionné démarre.

REMARQUE

Datacast 1
Datacast 2
Datacast 3
Datacast 4

Datacasts 1/4
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utilisation du pack plus
Le pack plus vous permet d’utiliser différentes fonctions : lecture de texte, 
jeux, réglage de l’alarme, etc.
LECTURE DE TEXTE
Qu’il s’agisse d’un roman, d’un scénario ou d’un article, votre lecteur MP3 vous permet de le lire 
tout en écoutant de la musique !

 Avant de démarrer- Allumez le lecteur et vérifi ez la batterie. Transfert de fi chiers texte vers 
le lecteur avec <EmoDio>. Reportez-vous à la page 33.
Réglez la langue du texte dans <Settings> (Paramètres) → <Language> (Langue) → 
<Contents> (Sommaire). Reportez-vous à la page 26.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Text> (Texte), puis sur [ ].
La liste des fi chiers texte s'affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le fi chier texte souhaité, puis sur [ ].

Le texte s'affi che à l'écran.
Accéder à la page précédente/suivante
Appuyez légèrement sur le bouton [Gauche, Droite].

 Appuyez longuement sur le bouton [Gauche, Droite] pour accéder de manière 
continue à la page précédente/suivante.

 Vous pouvez également utiliser la fonction <File Browser> (Dossier Navigateur) pour 
rechercher un fi chier texte. Reportez-vous à la page 21.
Votre lecteur MP3 prend en charge les fi chiers au format TXT en mode Texte.

REMARQUE

REMARQUE

Prime Pack

Text
Games
Alarm 
World Clock
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UTILISATION DU MENU TEXTE
Ecouter de la musique pendant l’affi chage de votre texte
Vous pouvez écouter la dernière musique lue pendant l’affi chage de votre 
texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Music> (Musique), puis sur [ ].

Le menu <Music> (Musique) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner le mode souhaité, puis sur [ ].
<Off> (Arrêt) :  Aucune musique de fond ne peut être lue 

pendant l’affi chage de votre texte.
 <On> (Marche) :  Vous pouvez écouter la dernière 

musique lue pendant l’affi chage de votre texte.

Accéder à la première page
Utilisez cette fonction pour affi cher le texte de la première page.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che.

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Go to 1st Page> (Aller à la 1ère 
page), puis sur [ ].

Une fenêtre de confi rmation s’affi che.
3. Appuyez légèrement sur le bouton [Gauche, Droite] 

pour sélectionner <Yes> (Oui), puis sur [ ].
 Permet d’accéder à la première page.

Pour quitter le menu, appuyez légèrement sur [ ].
REMARQUE

Book1

It's a common fantasy: 
rewind your life, erase all the 
mistakes and cringe-worthy 
moments and start over 
with a clean slate. But for 
Samantha Newly, the fantasy 
is far too real.

45.40%

Music
Go to 1st Page
Add Bookmark
Go to Bookmark 
Delete Bookmark
Font Size
Text Viewer Col..

Book1
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mistakes and cringe-worthy 
moments and start over 
with a clean slate. But for 
Samantha Newly, the fantasy 
is far too real.

45.40%

Music
Go to 1st Page
Add Bookmark
Go to Bookmark 
Delete Bookmark
Font Size
Text Viewer Col..
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UTILISATION DU MENU TEXTE (Suite)
Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.
1. Appuyez légèrement sur [ ] à la page voulue 

pendant la consultation d'un texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Add Bookmark> (Ajouter 
signet), puis sur [ ].

 L'écran du texte actuel est associé à un signet et le 
symbole [ ] s'affi che dans le coin supérieur gauche. 

 La fenêtre Réécrire apparaît si un signet a déjà été 
défi ni. Si vous sélectionnez <Yes> (Oui), le signet préalablement défi ni est 
supprimé et un nouveau signet est ajouté.
 Un signet peut être défi ni pour chaque fi chier texte (50 signets au maximum).

Accès à/Suppression d’un signet
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Go to Bookmark> (Accéd. 
à Signet) ou <Delete Bookmark> (Supprimer 
signet), puis sur [ ].

 Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).

REMARQUE
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It's a common fantasy: 
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UTILISATION DU MENU TEXTE (Suite)

Modifi er la taille de la police
Vous pouvez modifi er la taille de la police utilisée dans le texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Font Size> (Taille police), puis 
sur [ ]. 

Le menu <Font Size> (Taille police) s’affi che.

3. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner la taille de police 
souhaitée, puis sur [ ].

  Choisissez entre <Small> (Petit), <Medium> (Moyen) et <Large>.

Réglage de la couleur de la visionneuse de texte
Choisissez la couleur d’affi chage du texte.
1. Appuyez légèrement sur [ ] pendant l’affi chage 

du texte.
Le menu <Text> (Texte) s’affi che

2. Appuyez légèrement sur le bouton [Haut, Bas] 
pour sélectionner <Text Viewer Color> (Coul. 
visionn. text), puis sur [ ].

 La fenêtre du menu <Text Viewer Color> (Coul. 
visionn. text) apparaît.

3. Appuyez légèrement sur le bouton [Gauche, 
Droite] pour sélectionner la couleur de la 
visionneuse de texte souhaitée, puis sur [ ].

 Sélectionnez l'une des options comprises entre <Type 1> et <Type 6>.

Book1

It's a common fantasy: 
rewind your life, erase all the 
mistakes and cringe-worthy 
moments and start over 
with a clean slate. But for 
Samantha Newly, the fantasy 
is far too real.
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Add Bookmark
Go to Bookmark 
Delete Bookmark
Font Size
Text Viewer Col..
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LECTURE DE JEUX FLASH
Votre lecteur mp3 est livré avec des jeux passionnants qui sont préchargés sur l’appareil !

  Avant de démarrer- Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
 Appuyez légèrement sur [ ] pour aller à l’écran précédent.
Appuyez longuement sur [ ] pour accéder à l’écran du menu principal.

1. Appuyez longuement sur [ ] pour accéder à l’écran du menu 
principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che.
3. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner <Games> (Jeux), puis sur [ ].
La liste <Games> (Jeux) s’affi che.

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner le jeu souhaité, puis sur [ ].

Baseball
Défi ez l'un des meilleurs lanceurs de la ligue de base-ball, 
dans cette version vidéo du sport favori des américains.
Appuyez légèrement sur le bouton [Haut, Bas, Gauche, 
Droite] pour sélectionner un menu ou une fonction.
Appuyez légèrement sur la touche [ ] pour lancer ou 
frapper la balle.

Pizza Delivery
Essayez de livrer la pizza en temps et en heure en 
évitant les nombreux obstacles qui jalonnent votre 
parcours.
Appuyez légèrement sur [ ] pour sauter par-dessus 
l'obstacle.

REMARQUE

Prime Pack

Text
Games
Alarm 
World Clock



utilisation du pack plus_ 81

LECTURE DE JEUX VIDEO (Suite)
Honeybee
Dans ce puzzle, vous devez associer plus de 3 blocs 
pour gagner des points.
Utilisez le bouton [Haut, Bas, Gauche, Droite] pour 
sélectionner un menu ou choisir l’orientation du bloc.
Appuyez légèrement sur [ ] pour sélectionner ou 
annuler.

Jungmumun
Dans ce jeu, qui exige une capacité à réagir 
instantanément, vous devez retirer la pierre en fonction 
du sens de la fl èche qui apparaît dessus.
Utilisez les boutons [Haut, Bas, Gauche, Droite] et [ ] 
pour retirer la pierre.

Food King
Jeu de réfl exion dans lequel vous devez préparer 
autant de nourriture que possible en changeant l'ordre 
de trois blocs selon 3 orientations : largeur, longueur et 
diagonale.
Utilisez le bouton [Gauche, Droite] pour déplacer un bloc.
Utilisez le bouton [Haut] pour changer la position d’un bloc.
Appuyez légèrement sur le bouton [Bas] pour faire 
tomber le bloc.

Des jeux peuvent être ajoutés ou modifi és sans avis préalable.
 Pour plus d'informations sur les règles du jeu, consultez la section Aide.REMARQUE
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REGLAGE DE L’ALARME
Ce lecteur dispose d’une alarme dont la désactivation peut être programmée à 
une heure défi nie.

Avant de démarrer - Réglez la date et l'heure actuelles. Reportez-vous à la page 27.

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <Alarm> (Alarme), puis sur [ ].

4. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <New Alarm> (Nouvelle alarme), puis sur [ ].

La fenêtre Réglages nv alarme apparaît.

5. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner la fréquence de l’alarme, puis sur le bouton 
[Droite].

 Vous avez le choix entre les options suivantes : <Once> 
(Une fois), <Everyday> (Ts les jours), <Mon~Fri> (Lun~Ven), 
<Mon~Sat> (Lun~Sam), <Sat~Sun> (Sam~Dim) et <Off> 
(Arrêt).

6. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner la fréquence de l’alarme, puis sur le bouton 
[Droite].

7. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner les minutes, 
puis sur le bouton [Droite].

8. Appuyez légèrement sur le bouton [Haut, Bas] pour sélectionner <AM> ou 
<PM>, puis sur le bouton [Droite].

Prime Pack

Text
Games
Alarm 
World Clock

Alarm

New Alarm
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REGLAGE DE L’ALARME (Suite)
9. Appuyez légèrement sur le bouton [Haut, Bas] pour 

sélectionner une sonnerie d’alarme, puis sur le bouton 
[Droite].

 Sélectionnez l’une des options disponibles : <Alarm Sound 1> 
(Son Alarme 1), <Alarm Sound 2> (Son Alarme 2) ou <Alarm 
Sound 3> (Son Alarme 3) ; le fi chier musical est ajouté à la 
sonnerie d’alarme et à la radio FM.

10. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner un intervalle d’alarme, puis sur le bouton [ ].

 Vous avez le choix entre les options suivantes : <Interval : Off> 
(Intervalle : Arrêt), <Interval : 3min> (Intervalle : 3 min), <Interval: 5min> (Intervalle : 5 
min) et <Interval: 10min> (Intervalle : 10 min).
La fenêtre de confi rmation d'enregistrement apparaît.

11. Appuyez légèrement sur le bouton [Gauche, Droite] pour sélectionner <Yes> 
(Oui), puis sur [ ].

 Lorsque le réglage de l'alarme est terminé, le symbole ( ) apparaît en haut de l'écran.

Vous pouvez enregistrer jusqu'à 7 alarmes.
 Le lecteur émet l'alarme lorsqu'il atteint l'heure programmée.
Pour arrêter l'alarme, appuyez légèrement sur [ ].
Lorsque la fenêtre de confi rmation apparaît, appuyez légèrement sur le bouton 
[Gauche, Droite] pour sélectionner <Yes> (Oui), puis sur [ ]. Cette opération permet 
de quitter l’alarme et de revenir au menu principal.

REMARQUE

New Alarm Settings

Once

Alarm Sound 1

Interval : Off

08 00 AM
▲

▼ 
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REGLAGE DE L’ALARME (Suite)
Modifi er le réglage de l’alarme
1. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner le réglage à modifi er dans la 
liste des alarmes, puis sur [ ].

La fenêtre Régl. alarme apparaît.

2. Utilisez les boutons [Haut, Bas, Gauche, Droite] 
et [ ] pour modifi er les réglages de votre choix.

Supprimer un réglage d’alarme
1. Appuyez légèrement sur le bouton [Haut, Bas] 

pour sélectionner le réglage à supprimer dans la 
liste des alarmes, puis sur [ ].

Le menu <Delete> (Supprimer) apparaît.

2. Appuyez légèrement sur [ ].
La fenêtre de suppression apparaît.

3. Appuyez légèrement sur le bouton [Gauche, Droite] 
pour sélectionner <Yes> (Oui), puis sur [ ].

L’alarme sélectionnée va être supprimée.

Alarm

New Alarm 
08:00 AM

Alarm

New Alarm 
08:00 AM

Delete
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AFFICHAGE DE L'HORLOGE UNIVERSELLE
Vous pouvez vérifi er l’emplacement et les date et heure des principales villes à 
travers le monde en vous basant sur leurs fuseaux horaires respectifs.

 Avant de démarrer - Réglez la date et l'heure actuelles. Reportez-vous à la page 27.
Réglez le fuseau horaire souhaité dans <Setting> (Paramètres) → <Time> (Heure) 
→ <Time Zone> (Fuseau hr).

1. Appuyez longuement sur [ ] pour accéder à l’écran du 
menu principal.

2. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner <Prime Pack> (Pack plus), puis sur [ ].

La liste <Prime Pack> (Pack plus) s’affi che.

3. Appuyez légèrement sur le bouton [Haut, Bas] pour 
sélectionner <World Clock> (Horl. mond.), puis sur [ ].

L'écran <World Clock> (Horl. mond.) apparaît.

4. Appuyez légèrement sur le bouton [Gauche, Droite] pour 
sélectionner un fuseau horaire.

Vous pouvez vérifi er l’heure locale du fuseau horaire suivant.
(‘/’ indique le fuseau horaire standard de la région)
Cape Verde / London, Lisbon / Rome, Paris, Berlin, Stockholm, Madrid, Frankfurt/ 
Athens, Helsinki, Cairo, Ankara / Moscow, Riyadh / Abu Dhabi, Muscat / Tashkent, Ashgabat /
Alma Ata, Kathmandu / Bangkok, Jakarta, Rangoon / Hongkong, Beijing, Manila, Singapore / 
Seoul, Tokyo, Pyongyang / Guam, Sydney, Brisbane / Okhotsk / 
Wellingtons, Oakland, Fiji / Samoa, Midway / Honolulu, Hawaii, Tahiti / Alyeska / 
Los Angeles, San Francisco, Vancouver, Seattle / Denver, Phoenix, Salt Lake City / 
Chicago, Dallas, Houston, Mexico City / New York, Miami, Washington DC, Montreal, Atlanta 
/ Caracas, LA Paz, Santiago / Buenos Aires, Brasilia, Sao Paulo / The middle Atlantic 

Prime Pack

Text
Games
Alarm 
World Clock
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dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP3, des 
solutions vous sont proposées dans cette liste. Si le problème persiste, 
contactez le service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allumera pas si la batterie est 
entièrement déchargée. Rechargez la batterie 
et remettez l’appareil sous tension.

• Appuyez sur le bouton de réinitialisation.

Les boutons ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur  est dirigé 
dans le sens de la fl èche. 

•  Vérifi ez que vous avez appuyé sur le bouton 
adéquat, puis essayez à nouveau.

• Appuyez sur le bouton de réinitialisation.

L’écran ne s’allume pas.

• Il se peut que les données affi chées à l’écran 
ne soient pas visibles sous les rayons directs du 
soleil.

• Si <Display Off> (Affi ch. Désactivé) est 
sélectionné dans <Settings> (Paramètres) → 
<Display> (Affi cher), l’écran s’éteint.
Appuyez sur un bouton et vérifi ez si l’écran 
s’allume.
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PROBLÈME SOLUTION

L’alimentation est 
coupée.

• Vérifi ez l’état de charge de la batterie.
• L’alimentation se coupe automatiquement lorsque 

la batterie est entièrement déchargée. Rechargez 
la batterie.

• Si <Auto Power Off> (Extinction auto) est 
sélectionné dans <Settings> (Paramètres) → 
<System> (Système), l’alimentation est coupée 
lorsque le lecteur est en mode Pause. Allumez le 
lecteur.

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction 
du mode son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite 
si vous exposez le lecteur à des températures 
basses ou élevées pendant des périodes 
prolongées.

Dysfonctionnement du 
programme EmoDio.

• Vérifi ez que votre ordinateur dispose de la 
confi guration requise.

La connexion à 
l’ordinateur est 
interrompue.

• Assurez-vous que le câble USB est branché 
correctement et essayez à nouveau.

• Appuyez sur le menu <Démarrer> de la barre 
d’outil de votre ordinateur pour lancer la mise à 
jour Windows. Redémarrez votre ordinateur et 
rebranchez l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si plusieurs programmes sont ouverts sur votre 
ordinateur (dont <EmoDio>), le taux de transfert 
du fi chier sera ralenti. Quittez les programmes 
que vous n’utilisez pas et procédez à nouveau au 
transfert.
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PROBLÈME SOLUTION

Le lecteur ne fonctionne 
pas.

• Vérifi ez que le fi chier disponible a bien été 
enregistré dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas 
endommagé.

• Vérifi ez que la puissance de la batterie est 
suffi sante.

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement 
branché. Rebranchez-le au besoin.

• Assurez-vous qu’il reste de l’espace disponible sur 
la mémoire.

• Appuyez sur le bouton de réinitialisation.

Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché 
durant le transfert du fi chier ou des données. 
Si tel est le cas, les fi chiers/données mais 
également l’appareil risquent d’être endommagés. 
Vous devez faire preuve d’une extrême prudence 
à cet égard car Samsung ne saurait en aucun cas 
être tenu responsable de la perte des données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR (débit 
binaire variable).

Affi chage anormal du 
nom de fi chier.

• Allez dans <Settings> (Paramètres) → 
<Language> (Langue (Language)) → 
<Contents> (Sommaire) depuis le menu 
principal et défi nissez la langue qui vous 
convient.

L’appareil est chaud.
• Les phases de chargement peuvent générer de la 

chaleur. Cela n’a aucune incidence sur la durée de 
vie de l’appareil ou sur son fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo

• Essayez à nouveau de télécharger le clip vidéo en 
passant par la fonction EmoDio.
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annexe
ARBORESCENCE DES MENUS
Voici une rapide présentation de la façon dont les menus et les fonctions sont 
organisés dans votre nouveau lecteur MP3.

Ecran de sélection du menu

Music Videos Pictures FM Radio Datacasts Prime Pack File Browser Settings

Text Menu 
Style

Games Sound

Alarm Display

World Clock Language

Time

System
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-S3
Puissance nominale 5,0 V CC / 500 mA
Alimentation de la batterie 
intégrée 580 mAh / 3,7 V CC

Compatibilité

AUDIO :  MPEG1/2/2.5 Couche 3 (8 kbps à 320 
kbps, 8 kHz à 48 kHz), WMA (48 kbps à 
192 kbps, 8 kHz à 48 kHz)

VIDEO :  SVI (vidéo : MPEG4, Audio : MP3 (44,1 
kHz, 128 kbps), Résolution : 208 X 176, 
Vitesse d'enregistrement : 15 images/
seconde)

IMAGE :  JPG (Progressif, Balayage séquentiel, 
Taille de fi chier : moins de 3 Mo)

Nombre de fi chiers pris en 
charge 5000 maxi. (dossier compris)

Sortie des écouteurs 20 mW/Ch. (France 5 mW/Ch.) (basé sur 16 Ω)
Bande de fréquences de la 
sortie 40 Hz à 20 kHz

Rapport signal-bruit 90 dB avec fi ltre passe bas 20 kHz (sur la base 
de 1 kHz, 0 dB)

Durée de lecture
Jusqu'à 25 heures de lecture musicale, jusqu'à 4 
heures de lecture vidéo
(sur la base de : MP3 128 kbps, Volume : 15, 
Mode Normal)

Plage de températures de 
fonctionnement -5 ~ 35°C (23~95°F)

Etui Revêtement métallique, plastique
Poids 53g
Dimensions (L x H x P) 44 X 95 X 9,8 mm
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Radio 
FM

Fréquence FM 87,5~108,0 MHz T.H.D. FM 1%

Rapport signal FM 55 dB Sensibilité FM utile 38 dBμ

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.
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LICENSE
L’appareil qui se trouve avec ce manuel de l’utilisateur est fournie sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée 
à une utilisation privée non commerciale par l’utilisateur fi nal pour les contenus sous 
licence. 
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit 
n’est cédé sous cette licence pour des caractéristiques ou des fonctions du produit 
qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

COMMENT ÉLIMINER CE PRODUIT (DÉCHETS 
D’ÉQUIPEMENTS ÉLECTRIQUES ET ÉLECTRONIQUES)
(Applicable dans les pays de l’Union Européen et aux autres pays européens 
disposant de systémes de collecte sélective) 
Ce symbole sur le produit ou sa documentation indique qu’il 
ne doit pas être éliminé en fi n de vie avec les autres déchets 
ménagers. L’élimination incontrôlée des déchets pouvant 
porter préjudice à l’environnement ou à la santé humaine, 
veuillez le séparer des autres types de déchets et le recycler 
de façon responsable. Vous favoriserez ainsi la réutilisation 
durable des ressources matérielles.
Les particuliers sont invités à contacter le distributeur 
leur ayant vendu le produit ou à se renseigner auprès 
de leur mairie pour savoir où et comment ils peuvent se 
débarrasser de ce produit afi n qu’il soit recyclé en respectant 
l’environnement.
Les entreprises sont invitées à contacter leurs fournisseurs et 
à consulter les conditions de leur contrat de vente. 
Ce produit ne doit pas être éliminé avec les autres déchets commerciaux.



ELIMINATION DES BATTERIES DE CE PRODUIT
(Applicable aux pays de l’Union européenne et aux autres pays européens 
dans lesquels des systèmes de collecte sélective sont mis en place.)
Le symbole sur la batterie, le manuel ou l’emballage 
indique que les batteries de ce produit ne doivent pas être 
éliminées en fi n de vie avec les autres déchets ménagers. 
L’indication éventuelle des symboles chimiques Hg, Cd 
ou Pb signifi e que la batterie contient des quantités de 
mercure, de cadmium ou de plomb supérieures aux niveaux 
de référence stipulés dans la directive CE 2006/66. Si 
les batteries ne sont pas correctement éliminées, ces 
substances peuvent porter préjudice à la santé humaine ou 
à l’environnement. 
Afi n de protéger les ressources naturelles et d’encourager la réutilisation du 
matériel, veillez à séparer les batteries des autres types de déchets et à les 
recycler via votre système local de collecte gratuite des batteries.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veuillez contacter le Service Consommateurs Samsung.

Samsung Service Consommateurs
3260 SAMSUNG (€ 0,15/Min) ou 08 25 08 65 65 (€ 0,15/Min)

www.samsung.com/fr


